Balloting & Handling Negative Votes
General Overview of Different Levels of Balloting

- The Committee on Standards (COS)
- Main Committee Ballot / Society Review
- Subcommittee Ballot
Balance and

Voting vs. Non-Voting
Balance of Interest

Classified technical committees are required to be balanced. Voting producers cannot out weigh the combined voting user and general interest.
Voting Rights: Voting vs. Non-Voting

- 1 official vote per interest (company)
- All are welcome to participate in technical discussions
- All members receive a ballot and are eligible to vote on technical issues
- All negatives are considered the same way
- However, Non-official voting negatives are not included in the requirements for a valid ballot
- Voting members can lose their vote for failure to return ballots (Inactivity)

*All = Voting and Non-Voting Members.*
The Subcommittee Ballot
Subcommittee Ballot

• Purpose of Subcommittee Ballot

➢ New Standards
➢ Major Revisions

• See Section 11.1 of ASTM Regulations on Issuance of Subcommittee Ballot
Subcommittee Ballot Qualifications

- Authorization of Subcommittee Ballots
  - Sub chair
  - Motion at Meeting (simple majority)

- Ballot Open for Minimum of 30 Days.

- Qualifications for Valid Subcommittee Ballot – 60% return and 2/3 affirmative
Sub Ballot Notification Email

To: Farrell, James

ASTM INTERNATIONAL
Helping our world work better

Subcommittee Ballot for Acceptance Specifications and Precast Concrete Box Sections - C13.07 (18-01)

To access the ballot to submit your vote, go to C13.07 (18-01) (ASTM login is required). The ballot will be open and available on the web from JUL 11, 2018 to AUG 13, 2018.

All voting members are required to return ballots. Your ballot response is important to the committee in obtaining the required 60% return for a valid ballot. Failure to return ballots may affect your voting status.

Please add comserv@astm.org to your address book to ensure delivery of ballot notifications and reminders. Do not reply to this automated email. For web support, contact support@astm.org.

Thank you for helping our world work better as an active ASTM international member!

Keep up with the latest ASTM news on Facebook, Twitter, and LinkedIn.

Read the latest from Standardization News, including articles, interviews, case studies, tips, and more: http://www.astm.org/standardization-news/
# Viewing a Ballot

## MyCommittees

<table>
<thead>
<tr>
<th>Committee C01 on Cement</th>
<th>Committee C07 on Lime and Limestone</th>
<th>Committee C12 on Mortars and Grouts for Unit Masonry</th>
<th>Committee C15 on Manufactured Masonry Units</th>
<th>Committee D05 on Coal and Coke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ballots</td>
<td>Rosters</td>
<td>Meetings &amp; Symposia</td>
<td>Minutes &amp; Agendas</td>
<td>Committee Documents</td>
</tr>
<tr>
<td>Ballots</td>
<td>Rosters</td>
<td>Meetings &amp; Symposia</td>
<td>Minutes &amp; Agendas</td>
<td>Committee Documents</td>
</tr>
<tr>
<td>Ballots</td>
<td>Rosters</td>
<td>Meetings &amp; Symposia</td>
<td>Minutes &amp; Agendas</td>
<td>Committee Documents</td>
</tr>
<tr>
<td>Ballots</td>
<td>Rosters</td>
<td>Meetings &amp; Symposia</td>
<td>Minutes &amp; Agendas</td>
<td>Committee Documents</td>
</tr>
</tbody>
</table>

## MyTools

- **Rosters**
  - **Committee C01 on Cement**
  - **Committee C07 on Lime and Limestone**
  - **Committee C12 on Mortars and Grouts for Unit Masonry**
  - **Committee C15 on Manufactured Masonry Units**
  - **Committee D05 on Coal and Coke**

- **MyOutstanding Ballots**:
  - D05 (21.09) closos Jan 12
  - D30 (21.09) closed Dec 31
  - F18.15 (21.09) closos Dec 24

- **MyNext Meetings**
  - Ballots & Workitems
  - Meetings, Minutes & Agendas
  - Additional Resources
<table>
<thead>
<tr>
<th>Item No.</th>
<th>Sub No.</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Revision Of C1432-2016B Specification for Precast Reinforced Concrete Monolithic Box Sections for Culverts, Storm Drains, and Sewers WK63980 PDF (232K) (SEE VOLUME 04.05) TECHNICAL CONTACT: George W Hodge <a href="mailto:wayne.hodge@rennerpipe.com">wayne.hodge@rennerpipe.com</a> (832) 580-5368</td>
</tr>
</tbody>
</table>

**Negative with Statement**

Negatives are acted upon at a meeting or by ballot. If your negative is handled by ballot, only your written statement will be included. It is important to submit a complete statement identifying the applicable section(s) of the ballot item, the reason(s) for your negative vote, and if possible, alternate wording to satisfy your negative.

**Enter Section #**

Edit ▶ Insert ▶ View ▶ Formal ▶ Table ▶ Tools ▶

- Ford Family
- Ford Sizes

Enter Statement (no images)

- **ADD ANOTHER STATEMENT**
- **Upload a File**
  - **CHOOSE FILE**
  - **UPLOAD FILE**
Subcommittee Ballot Results

• Ballot Results Summary

➢ Negatives and Comments are posted online within 24 hour

➢ Closing Report includes links to all the comments and negatives after the ballot closes
<table>
<thead>
<tr>
<th>Committee C01 on Cement</th>
<th>Committee C07 on Lime and Limestone</th>
<th>Committee C12 on Mortars and Grouts for Unit Masonry</th>
<th>Committee C15 on Manufactured Masonry Units</th>
<th>Committee D05 on Coal and Coke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ballots</td>
<td>Ballots</td>
<td>Ballots</td>
<td>Ballots</td>
<td>Ballots</td>
</tr>
<tr>
<td>Rosters</td>
<td>Rosters</td>
<td>Rosters</td>
<td>Rosters</td>
<td>Rosters</td>
</tr>
<tr>
<td>Meetings &amp; Symposium</td>
<td>Meetings &amp; Symposium</td>
<td>Meetings &amp; Symposium</td>
<td>Meetings &amp; Symposium</td>
<td>Meetings &amp; Symposium</td>
</tr>
<tr>
<td>Minutes &amp; Agendas</td>
<td>Minutes &amp; Agendas</td>
<td>Minutes &amp; Agendas</td>
<td>Minutes &amp; Agendas</td>
<td>Minutes &amp; Agendas</td>
</tr>
<tr>
<td>Committee Documents</td>
<td>Committee Documents</td>
<td>Committee Documents</td>
<td>Committee Documents</td>
<td>Committee Documents</td>
</tr>
<tr>
<td>Standards Tracking</td>
<td>Standards Tracking</td>
<td>Standards Tracking</td>
<td>Standards Tracking</td>
<td>Standards Tracking</td>
</tr>
</tbody>
</table>

| MyTools                        | Roster Maintenance 362             | Negative & Comments 11                              | MyOutstanding Ballots 3                     | MyNext Meetings 1                |
|                                | MyWork Items                       |                                                     | MyCollaboration Areas                       |                                  |
|                                | Ballots & Workitems                |                                                     |                                              |                                  |
|                                | Meetings, Minutes & Agendas        |                                                     |                                              |                                  |
|                                | Additional Resources               |                                                     |                                              |                                  |
My Ballots

Committee F18 Ballots

You are an Officer or Technical Contact of the committee and/or subcommittees listed under the 'Ballot Queue' column, below. To access a listing of items that have been submitted for the next ballot, click on the ballot link.

<table>
<thead>
<tr>
<th>Ballot Queue</th>
<th>Committee Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F18</td>
<td>Electrical Protective Equipment for Workers</td>
</tr>
<tr>
<td>F18.15</td>
<td>Worker Personal Equipment</td>
</tr>
</tbody>
</table>

You are a member of the committee and/or subcommittees listed under the 'Ballot' column, below. To access a complete list of all open ballots, click on 'All Ballots', above.

To Vote: Select a ballot below. You can review the items within it and select options to approve, disapprove or abstain. Click here for information on saving, reviewing and submitting votes, as well as for reviewing closed ballots and the input received on them.

Ballot item documents are not ASTM standards, and shall not be reproduced or recirculated in whole or in part without written authorization from ASTM. Review ASTM's Working Document Caveat Here.
Closed Ballots/Closing Report

F18 Closed Ballots and Closing Reports

To view the ballot items documents, click on the ballot designation link below. To view a Closing Report, click either Web View or PDF button.

<table>
<thead>
<tr>
<th>Letter Ballot</th>
<th>Closing Report</th>
<th>Issue Date</th>
<th>Closing Report Posted</th>
</tr>
</thead>
<tbody>
<tr>
<td>F18 (21-03)</td>
<td>WEB VIEW</td>
<td>August 20, 2021</td>
<td>September 24, 2021</td>
</tr>
<tr>
<td>F18.65 (21-03)</td>
<td>WEB VIEW</td>
<td>July 30, 2021</td>
<td>August 30, 2021</td>
</tr>
<tr>
<td>F18.60 (21-01)</td>
<td>WEB VIEW</td>
<td>July 14, 2021</td>
<td>August 16, 2021</td>
</tr>
<tr>
<td>F18.65 (21-02)</td>
<td>WEB VIEW</td>
<td>July 14, 2021</td>
<td>August 16, 2021</td>
</tr>
</tbody>
</table>
Closing Report

MyASTM / Ballot Negatives and Comments
Support Desk | Return to List of Ballots | Return to MyCommittees

SUB COMMITTEE BALLOT C13.07 (17-01)
CLOSING DATE: August 15, 2017
Filter Ballot Item(s) View:

All Ballot Items
001

To print or download individual negative votes and comments click the item number. Scroll to the bottom of the page to download more than one item at a time. Click here to download all negative votes/comments (PDF file).

Ballot Statistics:

<table>
<thead>
<tr>
<th>Committee</th>
<th>Sent</th>
<th>Returned</th>
<th>% Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>C13.0700</td>
<td>40</td>
<td>31</td>
<td>77.50%</td>
</tr>
</tbody>
</table>

Click here for information on ballot items without negatives or those with comments only.

ITEM | SUB | ACTION
-----|-----|----------------------------------------
001  | 07  | Revision of C1786-2015 Specification for Segmental Precast Reinforced Concrete Box Sections for Culverts, Storm Drains, and Sewers Designed According to AASHTO LRFD

TECHNICAL CONTACT:
Margaret Talou

WORK ITEM: WK59589

NEGATIVE VOTERS: (all subcommittee member negatives must be considered)
Steve Delia Russo

COMMENTS:
James A. Nystrom
In the summary H<2 ft (with traffic perpendicular to span) 
Area of box section resisting a truck WHEEL load (not axle) 
Clarification needs to be added that there are two wheels (one axle) per loaded lane and 
depending on the box geometry multiple loaded lanes (i.e. multiple wheels/axles) must 
be considered. The existing wording is too simplistic. Perhaps a figure is in needed.

regardless the first sentence of X1.2.4 needs to be corrected to be perpendicular and not parallel.
Affirmative with Comment(s)

Affirmative with Comment

Ballot Number: C13.07 (17-01)  Close Date: AUGUST 14, 2017
Item Number: 001  Revision Of C1786-2016 Specification for Segmental Precast Reinforced Concrete Box Sections for Culverts, Storm Drains, and Sewers Designed According to AASHTO LRFD WK59589 (SEE VOLUME 4.5 )

TECHNICAL CONTACT: Margarita Takou

Member's Name: James A Nystrom
Address:

Phone Nr: Fax Nr:

Email Address:
File Attachment:

Statement:

Section  Statement

In paragraph X1.2.3, last sentence, the word “consideration” connotes, in my understanding, that the use or value of the MPF is an option. I think a stronger word should be used.
The Three-Step Approach to Handling Negative Votes

1. COMMUNICATION

2. CONSIDERATION

3. DOCUMENTATION
Six Resolutions of a Negative Vote

- Persuasive
- Withdrawn
- Withdrawn with Editorial Change(s)
- Not Related
- Not Persuasive
- Previously Considered
Persuasive

- General Agreement
- Lack of a “not persuasive” motion
- A “not persuasive” motion fails (does not achieve a 2/3 affirmative)
- Item is removed from ballot for further consideration
Withdrawn

➢ Withdrawn by the voter

➢ May withdraw negative at any time

➢ Ballot item moves forward
Withdrawn with Editorial Change

➢ Withdrawn by the voter/agreed as editorial

➢ Editorial change introduces no change in technical content, but corrects typos or reduces ambiguity

If editorial changes are involved, please include for next level of balloting
Not Persuasive and Not Related

- Motion/Second/Rationale
- 2/3 affirmative vote at a meeting or via ballot
- Negatives that are determined Not Related must be addressed as items of new business
Previously Considered

➢ Note that the option is not presented systematically.

➢ Vote count and rationale need to be provided.
The Main Committee Ballot
Initiation of Main Committee Ballots

• **Submittal Requirements:**

  ➢ For items that had Not Persuasive/Not Related negatives on the subcommittee ballot, you must include the following:

    ➢ Name and affiliation of negative voters
    ➢ Negative voter’s statements
    ➢ Resolution, vote count, and rationale
    ➢ Numerical results of the subcommittee ballot

  ➢ Open for 30 Days

  ➢ Simultaneous with Society Review
Concurrent Ballots

- Balloting Subcommittee & Main Committee simultaneously
- Used for revisions, withdrawals, or new standards that have undergone at least one subcommittee ballot.
- Note - Reapprovals are balloted at Main Only.
- No sub-ballot required.
- Same requirements as Main Committee Ballot
- Simultaneous with Society Review
- Authorization
Qualifications for Valid Main Committee / Concurrent Ballots

➢ 90% Affirmative of Combined Affirmative & Negative Votes

➢ 60% Return

➢ Late Ballot Returns

➢ Closing Reports

➢ Final Ballot Results

➢ Disposition of Negatives

➢ Affirmative Votes w/ Comments
Society Review

➢ In Tandem with Main Committee Ballot
➢ Notifications posted on ASTM Website
➢ Requirements
➢ Disposition of All Negatives
Society (Public) Review

Society (Public) Review of Main Committee Ballot Actions

December 2021

Deadline for Receipt: Must be received before January 1, 2022

The items listed are currently being balloted by the corresponding main committee and are submitted here for review. To request copies of proposed new standards and revisions of standards for review and voting purposes only, please email socrev@astm.org and provide the following information:

- Your name
- Your member number
- The designation and title of the main committee of interest (e.g., A04 on Iron Castings)
- The designation of the ballot (e.g., #00-01)
- The specific item(s) (e.g., Item 22)

After receiving the items you've requested, if you would like to comment or vote negative you may submit additional correspondence to ASTM Headquarters. All comments and negatives submitted by Society members will be considered by the originating subcommittee and main committee.

Download Ballot Actions
Committee on Standards (COS)

- 9 Member Group Representing ASTM Committees
- Due Process
- Appeals Based on Procedural Matters (NOT Technical)
- COS Ballot Procedures
- Final Approval
Summary

Committee on Standards

Society Review

Main Committee

Subcommittee

Task Group

Final Review and Approval of Procedures (9 Member Group)

Society Review
NO % Return Required
NO % Affirmative Required

Main Committee
60% Return Required
90% Affirmative Required

Subcommittee
60% Return Required
2/3 Affirmative Required

Task Group
Membership Not Required
Communication/Consideration/Documentation

1. **Communication** – Meeting agendas, correspondence, direct contact between member & negative voter and other documentation

2. **Consideration** – Both subcommittee and main committee at a meeting or via ballot

3. **Documentation** – Online negative resolution tool, minutes, correspondence
Negatives and Comments

<table>
<thead>
<tr>
<th>ITEM</th>
<th>SUB</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>02</td>
<td>Revision Of C0076-2018 Specification for Reinforced Concrete Culvert, Storm Drain, and Sewer Pipe</td>
</tr>
</tbody>
</table>

TECHNICAL CONTACT: Ryan Pelter

WORK ITEM: WK60751

<table>
<thead>
<tr>
<th></th>
<th>Main</th>
<th>Sub</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affirmative</td>
<td>55</td>
<td>30</td>
</tr>
<tr>
<td>Negative</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Abstain</td>
<td>13</td>
<td>6</td>
</tr>
<tr>
<td>%Affirmative</td>
<td>96.49</td>
<td>96.77</td>
</tr>
</tbody>
</table>

NEGATIVE VOTERS: (all ASTM member negatives must be considered)

New! Timothy J McGreath

New! William F Washabaugh

COMMENTS:

New! Tyson H Hicks
Resolution Options

MAIN COMMITTEE BALLOT C13 (17-07)
ITEM 001 - REVISION OF C0076-2016

Submit disposition of Timothy J McGrath negative vote. Click here to view negative.

- FAIL - (Item failed percent affirmative requirement)
- REMOVED FOR REBALLOT (Item removed from ballot by TC and SC - Attach next ballot file required)
  Choose File: No file chosen
- PERSUASIVE - (Any part of the negative vote was found persuasive; Item removed from ballot)
- WITHDRAWN (Entire negative vote was withdrawn without editorial changes)
- WITHDRAWN WITH EDITORIAL CHANGES (Entire negative vote was withdrawn with editorial changes)
  Clearly distinguish editorial changes from the ballot item using "track changes" or provide in a separate list format (attach below). Please do not provide a clean copy of the document. Submission may be made in separate document.
  Choose File: No file chosen
- NOT PERSUASIVE - (Entire negative vote was found not persuasive or there is a combination of not persuasive and not related or withdrawn dispositions)
- NOT RELATED (Entire negative vote was found not related or there is a combination of not related and withdrawn dispositions)

Clear Resolution  Accept Resolution  Cancel
Not Persuasive Ruling

MAIN COMMITTEE BALLOT C13 (17-07)
ITEM 001 - REVISION OF C0076-2016

Submit Disposition of Timothy J McGreath negative vote.
Click here to view Negative Vote.

Subcommittee Meeting Date:          Main Committee Meeting Date:  
Or Via                            Or Via
Ballot - enter data as in MCS, e.g. F150109 Item - enter using three places, e.g. 001
If there are multiple resolutions by ballot indicate the ballot item number in the ruling rationale.

Ballot:          Item:          Ballot:          Item:          

<table>
<thead>
<tr>
<th>Ruling</th>
<th>Ruling Rationale</th>
<th>Subcommittee Vote Count</th>
<th>Main Committee Vote Count</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>For</td>
<td>Against</td>
</tr>
<tr>
<td>1</td>
<td>Choose Ruling</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Enter Rationale</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Add Next Resolution

Save and Return Later  Submit Resolution  Cancel

© ASTM International
Helpful Hints

➢ Ballot controversial sections individually

➢ Use good judgment when balloting sections separately

➢ Provide clear and informative cover letter for ballot item(s)

➢ Try to contact the negative voter before the meeting
More Hints

➢ Address each portion of the negative vote

➢ Provide editorially revised document when resolving a negative vote as withdrawn with editorial changes

➢ Comments are intended for editorial issues or technical items of new business
Resources

➢ ASTM Regulations –
  https://www.astm.org/media/pdf/regs_Regulations.pdf

➢ ASTM Form and Style Manual –
  https://www.astm.org/FormStyle_for_ASTM_STDS.html

➢ ASTM Technical Committee Officer Handbook -

➢ Where to download the ppt presentation:
  https://www.astm.org/products-services/training-courses/member-training.html
Thank you for your attention!